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80 cADMIN Analytics: Virtual Meeting Statistics Dashboards

Where: cADMIN>Analytics Dashboard Contents

» CTI Analytics (CTIA) vs. Google Analytics (GA)

» Attendees Per Day

Analytics Tab—providing interactive visual and tabular » Total Attendees

analysis of meeting data to discover trends that can help in » Setup Analytics

programming and marketing » Cards' (e.g. Attendee, Session, Presentation, etc.)
« Attendee

Who can access: CS, Authorized Client Staff

@ People Submissions Reviewers Sessions i F i i Onsite Reports Analytics Settings Configuration O Sess | O n
Meeting statistics D [ Export Data %G Report Builder ° P I"es e n ta ti O n
O Tips v Total Attendees: EEZ3 | ATTENDEES PER DAY TOTAL ATTENDEES |

View different meeting metrics (] B t h
with the top drop-down menus, L

and then segment those results

with the bottom dropdown N

menu. Meeting statistics can be L4 S n r h |
exported as a CSV file for D O S O S D S
further analysis

Whw A RAw 2Aw A 2BAw 26Am Ax 28Aw M NAw 2May  3May  dMay  SMay  GMay  TMay  BMay  OMay  T0May 1My 12May ° CME (ie Certi-ﬁcate Statistics)
.C.,

D Howto (4 h

> Analyze Statistics N 5 o E t D t
a ” il
> Analyze Total Attendees Attendee [ EXPORT Session [ EXPORT Presentation [ EXPORT X D O r a a
> Export Dashboard Data Attendee Count All Dates v | Top 50 by Attendees Visiting Session Page v | Top 50 by Attendees Visiting Presentation Page v .
> Export Meeting Data ] ! ! u I C k
1 Day # -1 LML 1# -] d Title # -]
Glossary (17) ~
8 i 2021-03-08 n 994 9 259 180 ° F u | |
> Attendee Count

> Attendees Visiting 2021-03-09
Presentation Page

3 {

3 q
> Attendees Visiting Session 20210310 1 3 s 74 95 Mut 102 O U Se Ca Ses
Page : i

3 ]

846 372 Sest 107

> Attendees Watching 2021-03-11 655 ] Deci 102 . .
2 Bttt e o e Sponsor Banner Unique Views
> Booth Type

> Certificate by Registration
Code

2021-03-15

. . . Attendee Count All Dates by Registration Code V| ‘ Attendees by Registration Code V‘ ‘ Attendees by Registration Code v © EX h i b ito r B O Ot h C O m Da ri S O n S (i n C | u d e S Vi d e O)
> Certificate Count By Day
e : . : » Popular Sessions & Presentations (includes video)
> Hours Watched [ z i
= t : : * FAQs
CONTACTLS o o 5

» Glossary




59D CTI Analytics (CTIA) vs. Google Analytics (GA)

CTIA data differs from GA and improves on it

Report Data Google Analytics CTI Analytics

Based on browser cookie. Numbers

Attendance inflated by attendees who block cookies. Based on registration or SSO at login
Updates 12-48 hours before all stats are updated. Ere]lza:\ed more frequently; not all dependent

CTI can use registration data to tie all site

Visitor identity  Anonymous activity to individuals

Segments can be created with data collected
in registration or AMS including by Reg Type,
Region/Country, Member Type, Institution...

Only determined by other data Google

>egmentation has collected on visitors from other sites.

For most applications, if attendee CTI tracks viewing in increments of 120
watches for 15+ minutes, GA shows site  seconds and reports how much video has
exit been viewed and how many started to watch.

Video
consumption



80 Analytics Setup

S wawp

© ® N

To properly set up analytics in cAdmin to run on cAttendee, go to
Settings > Meeting information > Overview

Click Add Date Range

For now, the Purpose is ALWAYS VirtualMeeting

Instance/edition name: ISA Vienna 2022 (name of meeting)

Start date is when the client wants to start collecting data (please set
in advance to meeting start)

Soft end date: CTI currently only looks at Hard end date for when to
end collecting data. But for now, set same as Hard end date

Hard end date: set for when data collection should stop

Notes: Additional optional notes

Click Save

Submissions Reviewers Sessions Sessioners Presentations

Meeting information & setup

(2,

Meeting instances / editions © ADD DATE RANGE
Purpose Label Start date

Soft end date

Meeting 1SA: Vienna 2021 £912/08/2021, 06:00 PM

Z12/21/202

Add date range
*Purpose
VirtualMeeting

*Instance/edition name
ISA Vienna 2022

* Start date
02/25/2022

*Soft end date
11/25/2022

*Hard end date
11/25/2022

Notes




80 Attendees Per Day

For meeting organizers, daily attendance is a top-of-mind concern. This chart, located at the top of the Analytics dashboard will provide
that information at a glance with a bar graph showing attendance by day.

Attendees Per Day

Submissions Reviewers Sessions Sessioners Presentations Campaigns Onsite Reports Analytics Settings Configuration Operation

Meeting statistics Hover over the bar graph to [ Export Data  %¥& Report Builder

view attendee count each day

| ATTENDEES PER DAY |TOTAL ATTENDEES |

Total Attendees [EZ1EY

27 Mar

Count: 902

8 Mar 9 Mar 10 Mar 11 Mar 12 Mar 15Mar 16 Mar 17 Mar 18 Mar 19 Mar 20 Mar 21 Mar 22 Mar 23 Mar 24 Mar 25 Mar 26Mar 27 Mar 28 Mar 29 Mar 30 Mar 31 Mar 1Apr 2 Apr 3 Apr 4 Apr SApr B Apr T Apr B Apr

Attendee [ EXPORT Session [ EXPORT Presentation [ EXPORT
Attendee Count All Dates V| | Top 50 by Attendees Visiting Session Page V| | Top 50 by Attendees Visiting Presentation Page v
Day # - & ] N.. T.. Title  # - & ] Title A. S. # -~ O
2021-03-25 1607 3 W Edu.. Novelt. 496 137 Real-worl.. eP.. e-P. 177
2021-03-26 1416 y) W Edu.. Lungc.. 473 31 First-Line.. Ab.. Pro.. 92
2010327 902 3 ¥ Mul. Optim.. 453 ] Antibody . Invi.. No.. 92
2021-03-30 481 1 WKey.. Heine . 436 32 Firstline . Ab. Pro. 84
2021-03-24 451 1 ®Pro. Proffer. 411 34 KRYSTAL.. Ab. Pro.. 83

Attendees Per Day '(Ij'gisattendee count is broken down into individual



80 Total Attendees

In the top right corner, next to Attendees Per Day, is Total Attendees

Submissions Reviewers Sessions Sessioners Presentations Campaigns Onsite Reports Analytics Settings Configuration Operation

Meeting statistics Hover over the line gra ph [ ExportData %3 Report Builder
to view total attendees _ ]
Total Attendess: . ATTENDEES PER DAY | TOTAL ATTENDEES
el Aendees: €Y attended to a certain date [§ -
25 Mar
Count: 2,129

e S

8 Mar 9 Mar 10Mar  11Mar 12 Mar 15Mar  16Mar  17Mar 18 Mar 19Mar  20Mar  21Mar  22Mar  23Mar  24Mar  25Mar  26Mar  27Mar 2BMar 20 Mar 30Mar 31 Mar 1 Apr 2 Apr 3 Apr 4 Apr S Apr & Apr 7 Apr B Apr

Attendee [T EXPORT Session [ EXPORT Presentation 7 EXPORT
Attendee Count All Dates V‘ ‘ Top 50 by Attendees Visiting Session Page ~ ‘ ‘ Top 50 by Attendees Visiting Presentation Page v
Day # ~ O Id N... T. Title £ - & Id Title  A. S.. # -~
2021-03-25 1607 3 W Edu.. Novelt.. 496 137 Real-w.. ePoster ePos.. 177
2021-03-26 1416 2 W FEdu. Lungc.. 473 31 First-Li.. Abstr. Proffe. 92
2021-03-27 902 5 % Mul.. Optim.. 453 b Antibo.. Invite.. MNovel .. 92
2021-03-30 481 1 WKey. Heine .. 436 32 First-li.. Abstr. Proffe. 84
2021-03-24 451 n Do Proffer a1 34 KRYST. Abstr_ Proffe. 83

A line graph that will consistently go up as more

Total Attendees attendees attend to a certain date



80 CTIl Attendee Statistics Dashboard

UNIQUE ATTENDEES ALL DATES

Attendee

[T EXPORT -

Attendee Count All Dates

v

>ATTENIJEE COUNT ALL DATES SEGMENTED BY REG CODE

ATTENDEE COUNT ALL DATES SEGMENTED BY REGION

ATTENDEE COUNT ALL DATES SEGMENTED BY MBR TYPE

Attendee Count All Dates

Day Rank - # 1]
2021-02-08 1931
2021-02-09 2 1834
2021-02-10 1707
2021-02-11 4 1569
2021-02-12 1460
2021-02-07 157
2021-02-15 7 241
2021-02-16 216
2021-02-19 184

Attendee Count All Dates by Registration Code

Attendee Session Count All Dates

Attendee Presentation Count All Dates

Attendee Count Meeting Dates

Attendee Session Count Meeting Dates

Attendee Presentation Count Meeting Dates
Attendee Count Post Meeting Dates

Attendee Session Count Post Meeting Dates
Attendee Presentation Count Post Meeting Dates

£+ Visible columns
DAY

RANK @

@ A INT
@ ALUS
@ CTI,ET, INT, WORLD

@ CTIETUS WORLD,EXHIBITOR

@ ET,US, INT
@ EXHIBITOR
@ INT A

@ INT A ET
@ INT.B

@ INT, B, ET

U

Attendee Count All Dates by Registration Code
Attendee Count All Dates by Region
Attendee Count All Dates by Member Type

Shows Unique Attendee Count as follows:
= Attendee Count All Dates
= Attendee Session Count All Dates
= Attendee Presentation Count All Dates
= Attendee Count Meeting Dates
» Attendee Session Count Meeting Dates
» Attendee Presentation Count Meeting Dates
» Attendee Count Post-Meeting Dates
» Attendee Session Count Post-Meeting Dates
» Attendee Pres. Count Post-Meeting Dates

The Attendee data can be seen in a graphical
representation and filtered by:

= Region (map)

= Registration Code (pie chart)

* Member Type (bar chart)

For further analysis, click Export to download data for:
»= Attendee Count All Dates Segmented by Region
» Attendee Count All Dates Segmented by Mbr. Type

Click Gear icon to choose columns displayed

Number of individuals who visited based

Attendee Count: on registration or SSO data.



80 CTI Session Statistics Dashboard

oo ’ Shows “Top 50" Sessions by:
ession [ EXPORT - .
= Those who have visited the Session page
Top 50 by Attendees Visiting Session Page ~ Top 50 by Attendees Visiting Session Page . .
Top 50 by Attendees Watching = Those who have watched the Session video
Rank a i Title " Top 50 by Hours Watched » Total amount of the video watched
Top 50 by Session Page Visits . ..
2 Basic Science 874 = Session page visits
2 6 Translational Research 839 2 Vicihlo colunns The Sessions data can be seen in a graphical
40 Lysosomal Diseases: Bench t.. 798 representation and filtered by:
4 S Basic Science 765 - Reg!on (map) )
- = Registration Code (pie chart)
4 4 Basic Science 765
- ere Disease Registes Pion. = For further anaIygs, click Ex'port tc? glownload data
_ for Top 250 Sessions by Unique Visits
7 8 Translational Research 701
_ T 54 Click Gear icon to choose columns displayed
10 Clinical Trials 668 Definition
Attendees by Registration Code v‘ BN \tendees by Registration Code Attendees Visiting Number of individual visitors to page. [Not known if
Attendees by Region Session Page: they stayed to watch session.]
@ A INTET
L L Attend_ees. Number of individuals who started to watch.
@ CT1, ET, INT, WORLD Watching:
: Sﬁ;ﬂ:fmwmmﬂ Hours Watched:  Total time attendees watched.
::THE'T”R Session Page Number of page visits [Include those who returned
o Visits: twice. Not known if they stayed to watch.]
@ NT.B
@ INT, B ET
168 W 8




80 CTI Presentation Statistics Dashboard

Presentation [ EXPORT Shows “Top 50" Presentations by:
Top 50 by Attendees Visiting Presentation Page v| _ : - ThOSe WhO have V|S|ted the Presentat|on page
—|_, Top 50 by Attendees Visiting Session Page = Those who have watched the Presentation video
Rank a Id Title " O Top 50 by Attendees Watching .
Top 50 by Hours Watched = Total amount of the video watched
1056 Impact of SARS-CoV-2 pande... 351 Top 50 by Session Page Visits - Presentation page visits
2 911 The importance of mass spec.. 314 T . . .
% Visible columns The Presentations data can be seen in a graphical
20 Proposed stages of cardiomy.. 301 representation and filtered by:
4 1019 MPS-specific physical sympt.. 272 m Region (map)
062 Miglustat does not enhance a 239 - Registration Code (ple chart)
1059 Fabry Outcome Survey (FOS):.. 239 For further analysis, click Export to download data for Top
7 909 Metabolizing profile of the cy _ 206 250 Presentations by Unique Visits
1479 IdeS: An enabling technology .. 200 Click Gear icon to choose columns displayed
1028 A phase /Il multicenter gene _. 199
; ; MY Attendees by Registration Code e
e 2l e —
L Attendees Visiting  Number of individuals visitors to page. [Not known
. Presentation Page: if they stayed to watch session.]
@ CT, ET, INT, WORLD
@ CTIETUSWORLD,EXHIBITOR
@ EXHIBITOR cvt;:::iies_ Number of individuals who started to watch.
@ INT, A g-
::E*ET Hours Watched: Total time attendees watched.
@ INT.B, ET Presentation Page  Number of page visits [Include those who returned
@ INT.EX Visits: twice. Not known if they stayed to watch.]
ER 4 h




80 CTIl Booth Statistics Dashboard — Attendees

Booth

7 EXPORT

Top 50 by Attendees Visiting Booth Page

w

Top 50 by Attendees Visiting Booth Page
Top 50 by Attendee Booth Actions
Top 50 by Attendee Booth Action Types

R.a Id Name SubEvents # o
8 Sanofi Genzyme Commercial [Exhibitor] 669
2 4 Takeda Pharmaceutical [Exhibitor] 536
10 Sanofi Genzyme Medical [Exhibitor] 512
4 43 Amicus Therapeutics [Exhibitor] 484
7 BioMarin Pharmaceutical [Exhibitor] 463
12 Chiesi [Exhibitor] 347
11 Orphazyme [Exhibitor] 260
25 Audentes, an Astellas Company  [Exhibitor] 244
30 Amicus Therapeutics [Exhibitor] 189
Attendees by Registration Code v

@ CT1, ET, INT, WORLD

@ CTIETUSWORLD EXHIBITOR
@ ET, US, INT

@ EXHIBITOR

@ INT A

@ INT A ET

@ INT B

@ INT, B, ET

@ INT, EX

@ INT, PA

WY

v

»

£* Visible columns

NAME

SUBEVENTS )
TYPE

CATEGORIES &

Attendees by Registration Code

Attendees by Region
Attendees by Member Type

Attendees by Booth Type
Attendees by Gallery Type

Shows “Top 50" by:

= Attendees Visiting Booth Page

= Attendee Booth Actions
= Attendee Booth Action Types

The Booth data can be seen in a graphical representation

and filtered by:

= Attendees by Registration Code (pie chart)

= Attendees by Region (map)

= Attendees by Member Type (bar chart)

= Attendees by Booth Type
= Attendees by Gallery Type

For further analysis, click Export to download data for

Top 250 by Unique Booth Visits

Click Gear icon to choose columns displayed

Attendees Visiting

Booth Actions /
Action Types

Booth Type

Gallery Type

Number of individuals who visited based on

registration or SSO data.

Actions are clicks on links or buttons. Types
include Submit Inquiry, Chat, Resource links

Benefit level, typically labeled as Platinum, Gold,

Silver, Bronze, etc.

Such as Profit and non-Profit, or Association Booth

and non-Association

10



80 CTIl Booth Statistics Dashboard — Actions

Booth

[ EXPORT

Top 50 by Attendee Booth Actions

M Emmmg Top 50 by Attendees Visiting Booth Page

Top 50 by Attendee Booth Actions

R.a Id Name SubEvents # o
8 Sanofi Genzyme Commercial [Exhibitor] 504

2 4 Takedz Pharmaceutical [Exhibitor] 402
10 Sanofi Genzyme Medical [Exhibitor] 356

4 43 Amicus Therapeutics [Exhibitor] 343
7 BioMarin Pharmaceutical [Exhibitor] 263
12 Chiesi [Exhibitor] 234

7 11 Orphazyme [Exhibitar] 208
25 Audentes, an Astellas Company  [Exhibitor] 175
39 Amicus Therapeutics [Exhibitor] 129

Booth Actions by Registration Code

.

@ CTI, ET, INT, WORLD

@ CTIETUS,WORLDEXHIBITOR
@ ET,US, INT

@ EXHIBITOR

@ NTA

@ INT A ET

@ INT B

@ INT, B, ET

@ INT EX

@ INT, EX,ET

16

Top 50 by Attendee Booth Action Types

£ Visible columns
SUBEVENTS @
TYPE

CATEGORIES Lo

By Total Booth Actions by Registration Code
Total Booth Actions by Region

Total Booth Actions by Member Type
Total Booth Actions by Booth Type

Total Booth Actions by Gallery Type
Total Booth Actions by Booth Action Type

Shows “Top 50" by:
= Attendees Visiting Booth Page
= Attendee Booth Actions
= Attendee Booth Action Types

For Booth Actions data can be seen in a graphical
representation and filtered by:
= Attendees by Registration Code (pie chart)
= Attendees by Region (map)
= Attendees by Member Type (bar chart)
= Attendees by Booth Type
= Attendees by Gallery Type

For further analysis, click Export to download data for
Top 250 by Unique Booth Visits

Click Gear icon to choose columns displayed

Number of individuals who visited based on

CIEE R L registration or SSO data.
Booth Actions / Actions are clicks on links or buttons. Types
Action Types include Submit Inquiry, Chat, Resource links
Booth Type Bgneﬂt level, typically labeled as Platinum, Gold,
Silver, Bronze, etc.
Gallery Type Such as Profit and non-Profit, or Association Booth

and non-Association



80 CTI Sponsor Banner Statistics

Sponsorships [ EXPORT
Top 50 by Total Impressions Vl_
Ba... Sponso... Opportunity Banner Name #.v
2 JanssenE..  ePosters Search Top 1518
1 ESMO Warkshops Search T..  ESMO Workshaps 1179
] Daiichi San.. Congress Bag Daichii CongressBag 339
6 ESMO News Page ESMO News ad 188
e Daiichi San.. Congress Bag Daichii Congress Bag 1

Impressions by Registration Code

@ 2210
@ 2211
@ 2712
@ 1213
@ 2714
@ 2215
@ 217
@ 2219
@ 220
@ 2221

1mnvY

mm d 10p 50 by Total Impressions
Top 50 by Unique Impressions
Top 50 by Unique Clicks
Top 50 by Total Clicks

£+ Visible columns
RANK &

BANNER ID
SPONSOR/BOOTH NAME
OPPORTUNITY

BANNER NAME

Impressions by Registration Code
Impressions by Region

Impressions by Member Type
Impressions by Sponsorship Opportunity

Dashboard

Shows “Top 50" by:
= Total Impressions
= Unique Impressions
= Unique Clicks
= Total Clicks

For Booth Actions data can be seen in a graphical
representation and filtered by:
= Impressions by Registration Code (pie chart)
= |mpressions by Region (map)
= Impressions by Member Type (bar chart)
= Impressions by Sponsorship Opportunity

For further analysis, click Export to download data for
Top 250 by Unique Booth Visits

Click Gear icon to choose columns displayed

Key Term Definition

Number of attendees who could have viewed

Impressions during the Sponsor Banner display.

Opportunity Location where Sponsor Banner is displayed.

12



80 CTlI CME Statistics Dash

[ EXPI X
J—' CERTIFICATES PER DAY
CME [ EXPORT—|
Certificate Count By Day v l Ll Cf EXPORT
Certificate Count By Day v
Day R # - n Certificate Count By Day
2020-10-08 414
2021-02-01 412 | - X
2020-10-07 324 [ %% Visible columns
20210131 : 246 !
RANK -
2021-02-02 189 | &
2020-10-00 162
2021-01-26 139
2021-01-27 110
2020-12-31 109
" . . | Certificates by Registration Code v
Certificates by Registration Code v >

@
@1
@R
®:
@3
o
@5
[ X3
@:
@

§
771 (14.6%)

1my

Certificates by Registration Code
Certificates by Region
Certificates by Member Type

noard — Certificates

Shows number of all the certificates received on a
specific day
= (e.g., 2020-10-08 Ranks #1 and 414 attendees
received a certificate)

Certificates can be filtered by:
= Registration Code (pie chart)
= Region
= Member Type

For further analysis, click Export to download data for
Certificates Per Day

Key Terms Definition

By Day that day

Certificate by

Registration Code Number of Registrations by Code #

Region (hover to see numbers)

Certificate Count Number of attendees who received a certificate

Certificates by Number of Registrations by Region in the world

13



80 Quick Export Dashboard Data (Limited to top #)

WORLD: WORLDSymposium 2021

S35 QVIRTUAL [ February 812, 2021 Export Data by clicking on “Export” For further analysis,
N a People Submissions Reviewers Sessions Sessioners Presentations data can be expo rted in a.csv fO rmat by day Of COl |eCti0n.
B Meeting statistics a [’,'Expon Data 21&3 Report Builder
Attendee et’. EXPORT Session 0 ‘17 EXPORT Presentation G 7 EXPORT
Fassssmmmmms ' :. . 4o CammmmmEmEEE
UNIQUE ATTENDEES ALL DATES E.TUP 250:SESSION UNIQUEVISITS TOP 250 PRESENTATION UNIQUEVISITS
ATTENDEE COUNT ALL DATES SEGMENTED BY REG CODE t
ATTENDEE COUNT ALL DATES SEGMENTED BY REGION For Sessions, this Export

ATTENDEE COUNT ALL DATES SEGMENTED BY MBR TYPE option only pulls the Top 250

a Export Analytics Data

Please remember that General Data Protection Regulations prohibit the unencrypted transmission and storage of Personally Identifiable Information (PIl) including email address. GDPR website. Treat this file with carel

14



80 Export All Meeting Data

a=2 WORLD: WORLDSymposium 2021
sms  QVIRTUAL (i} February 8-12,2021

Q Search @ Help ¥t What'sNew @ Feedback & Natalie Szulyk ~

@ a“ People Submissions Reviewers Sessions

Sessioners Presentations Campaigns Onsite Reports Analytics Settings Configuration Operation

Meeting statistics

Export Full Data
Data with names can be exported in a
.csv format by day of collection.

Step 1: Click “Export Data” in the upper
right-hand corner

Step 2: Click “"Okay”

Step 3: Choose Page Views, Video
Views, Booth Usage, CME Certificates,
CME Session Claims, Sponsorship
Clicks

Step 4: Choose day for export and
Download

e Export Analytics Data

Please remember that General Data Protection Regulations prohibit the unencrypted transmission and storage of Personally Identifiable Information (PIl) including email address. GDPR website. Treat this file with care!

CANCEL OKAY

Select a date

CANCEL

Date

‘ filter column...
Select view

all-days.csv
Type of View 2021-02-17 csv
O Pageviews O Videoviews O CME Certificates O CME Session Claims O Booth Usage O Sponsorships Clicks

CONTINUE

2021-02-16.csv

2021-02-15.csv

2021-02-14.csv

2021-02-13.csv

2021-02-12.csv

2021-02-11.csv

ololololololololo

2021-02-10.csv

CANCEL DOWNLOAD

15



(0 How many posters were viewed? How many views

1. Choose “Export Data” in the upper right-hand corner
2. Select "Page views” and "All days” (or any specific day)

3. Create a Pivot Table in Excel and choose the fields “PKey” (number of clicks), “SessionType” and “SessionTitle"

x AutoSave ':. Off :' meeting_10619_PageViews_days_all-days Evan Eisenmann  EE

File Home Insert Page Layout Formulas Data Review View Automate Help Acrobat

E= % D G |BED

Insert  Insert Refresh Change Data ear Select  Move

PivatTable Name: | Active Field:

'__r.| Fields, ltems, & Sets ~ |:|
i

|PivotTable12 | | [Count of PKey | B [

E COptions ~ '__' Field Settings =
PivotTable Active Field Group Filter Data Actions Calculations Towols

v | fx|| 42456

# of Clicks (or Page Views) per Session Type & Session Title

T : Ho | a

@ PivotTable Fields

) Row Labels - | Count of PKey
+ Basic-Translational-Clinical Roundtables 38

+ Dual Perspectives 105 ) )
# Lecture 22040 # of clicks per Session Type
+ Meet-the-Clinician-Expert Session 78 [] Year

+ Meet-the-Expert Session 301 [[] Month
+ Minisymposium 6208 [] Day

1] = Nanosymposium 10512 [] Hour
+ Networking/ Public Qutreach/ and Advocacy 138 Select "Session Type"’ [ Minute
3 + Neuroscience Meet-Ups 38

1 n 11 H - " Sessionlc
- poster [ aauss) PKey" and "Session Title U S::h’;':me
Abeta as a Therapeutic Target 21 SessionType
Action and Sensation During Reaching Movements 76
Addictive Drugs Affecting Development i L .,
Addictive Drugs and Psychedelics: Social Interactions and Sex Difference 63
Addictive Drugs: General Neural Mechanisms 55 Y Filters
Addictive Drugs: Pharmacology and Neural Mechanisms 21 i# of clicks per Session Title
Addictive Substances and Memory Mechanisms 54
Adnnarina Mninid and CadAaranna hinAid DAarnntAre 2A

(Grand Total of views is at the bottom)

PivatChart Recommended Field
ﬁ Slicer Timeline - Source ~ = PivotTable =22 PivatTables List

Choose fields to add te report:

each?

&

| 73 comments |

EEl=

+f- Field
Buttons||Headers

Show

I Columns

16



80 How can you differentiate on-demand, live-streaming, PDF?

1. Choose “Export Data” in the upper right-hand corner

2. Select "Video views"” and "All days” (or any specific day)

3. Create a Pivot Table in Excel and choose the fields “PKey” (number of clicks), and “ViewType”

x"  AutoSave (@ OfF) meeting_10619 VideoTracking_days_all-days (1) +*

File Home Insert Page Layout Formulas Data Review  \View
PivotTable Mame: | Active Field:
|PivotTableld | | |ViewType

E Options  ~ ’__|

PivotTable Active Field

| Jfx|| Row Labels

# of Clicks per View Type

Select "Export Data-> Video view"

Automate  Help  Acrobat

(e AR -
Refresh Change Data [ select

E‘ Mave PivotTable
Filter Data Actions

E Insert Slicer
[57 Insert Timeline

%_. Source ~
7

Number of clicks for that page,

Row Labels -~ ICount of PKey
514

3314

7432

Grand Total 11260

D = On-demand

P =PDF

L = Live-streaming
U = Undefined

or in this case, ViewType

'j‘ Fields, ltems, 8 Sets ~

e
El
Ba
Calculations

Select ViewType

Evan Eisenmann  EE

| B comments |
| Field List |
D] |E'|:| +/- Buttons |
| Field Headers |

Tools Show

PivotChart Recommended
PivotTables

PivotTable Fields

Choose fields to add to report:

[] Sessionld

[] SessionTitle

[] SessionType

[] SessionMumber

[] Presentationld

[] PresentationTitle
ViewType

Mare Tables...

Undefined - cannot be
determined. It could be
because it is a document
other than a video (e.g., until
recently, PDFs would fall in
that category), or because it
is an external video player
which is not reporting the
type of video-viewing back to
the CTI systems




(0 Sponsor Banner Unique Views

1. Choose a ‘Card’, such as Sponsorships (i.e., sponsor banner clicks) St LG ([, rurmlowr of

clicks) or Rank largest to
smallest to compare sponsor
banner unique clicks (i.e.,
different person clicks)

2. Filter the drop-down (e.g., Top 50 by Unique Clicks)
3. Click Export

- z | D E F G H
Sponsorships '_._l’ EXPORT > 1 jBoothName |BoothType lid Name SponsorshipTypeName BoothKey Value Rank
2 | Cogent Organiser 57 Organiser Congress Bag Inserts 419ae2d2-323d-490 125 1
Ton 50 by Uni Click 3 fMS Gold 37 Gold Satellite Inserts 0962e541-7041-4204 72 2
P y Unique Liicks v 4 §Am Platinum 31 Platinum Satellite Inserts e1796f78-f5ab-421c}; 61 3
5 JAm Platinum 20 Streaming right Streaming right e1796f78-f3ab-421cf 59 4
Bann... sp DP Ba.. — ﬂ 6 | Tak Bronze 38 Bronze Satellite Inserts 32cAfl15e-cb02-4d3g 55 5
7 | Bri Gold 30 Gold Satellite Inserts 9d56a444-f29e-4774 54 6
57 ESI CO’IQI’E‘... Organi... 125 8 JAsi Platinum 35 Platinum Satellite Inserts d231e65f-6e57-4feg 47 7
g Ms Gold 13 Programme Flat 2 right Programme Flat 2 right 0962e54f-7041-4204 46 8
- 10§ No Bronze 36 Bronze Satellite Inserts 924f1cd2-3c36-48 44 9
37 MS Sate Gold 72 11 ast Platinum 18 Streaming left Streaming left d231e65f-6e57-4fea a1 10
12 Ast Platinum 33 Platinum Satellite Inserts d231e65f-6e57-4fe] 38 11
a Am Sate Platinu... 61 13fJan Platinum 34 Platinum satellite Inserts £9873500-654c-4c90) 37 12
14} Jan Platinum 19 Streaming left Streaming left ©9873500-654c-4c90) 36 13
20 Am Strea. Strea. 59 15§ No Bror_ue 40 Bror_ue Congress Bag Inserts 924f1cd2-3c36-48fc 34 14
16§ Ast Platinum 62 Platinum Congress Bag Inserts d231e65f-6e57-4feq 32 15
_ 17 Ms Gold 46 Gold Congress Bag Inserts 0962e54f-7041-4204 29 16
a8 gk Satellit  Bronze 55 18} san Platinum 56 Platinum Congress Bag Inserts 29873500-654c-4¢90 29 16
19§ 1A Organiser 25 Streaming right Streaming right a67d1135-6d7b-43f 28 18
20§14 Organiser 54 Organiser Congress Bag Inserts ab7d1135-6d7b-43f 28 18
UI'iiE]L.IE Clicks b‘;’ REQiStIaHOﬂ Code “w 21) ESN Organiser 59 Organiser Congress Bag Inserts 419ae2d2-323d-490 27 20
22 Ast Platinum 16 Programme Flat 1 left  Programme Flat 1 left d231e65f-6e57-4feg 26 21
23 Mc Sponsor 58 Sponsor Congress Bag Inserts 56797f20-7a3b-43d 25 22
@ 220 244 MS Gold 5 Presenters Top Presenters Top 0962e54f-7041-420¢ 21 23
@ 2230 25Q ESP Organiser 44 Organiser Congress Bag Inserts 419ae2d2-323d-4904 24 23
2231 26J ESP Organiser 7 Programme Top Programme Top 4193e2d2-323d-430 24 23
274 Bri Gold 39 Gold Congress Bag Inserts 9d36a444-f29e-4774 23 26
@ 1232 28] Tak Bronze 60 Bronze Congress Bag Inserts 32c4f15e-cb02-4d3g 23 26
@ 231 290 IAS Organiser 29 Organiser My Playlist Top ab67d1135-6d7b-43f4 23 26
@ 2234 304 A Platinum 32 Platinum Congress Bag Inserts e1796f78-f5ab-421c) 23 26
@ 2235 31§ Ast Platinum 61 Platinum Congress Bag Inserts d231e65f-6e57-4fe] 21 30
@ 2236
@ 2237 .
i Currently, a booth is needed to Sponsor Banner
create a sponsor banner. The names and types
nw booth doesn't need to exist on
the attendee website or have

any content inside




(o Use Case — Exhibitor Booth Comparisons

Download a CSV file and use a pivot table in Microsoft Excel to compare booth statistics. There are many ways to do this, below is one way:

Analytics Dashboard > Export Data > Booth Usage

Typeof View

CANCEL

Select view

) Sponsorships Clicks
CONTINUE

B e A S

In Microsoft Excel, go to Insert > Recommended PivotTables

File Home Insert Page Layout Formulas Data Review View Help Acrobat
=] o= = I O~ 3y =]
2 E " 17 s h @ [ |«
PivotTabl{ Recommended [ Table strations I_ = PivotChart
- PivotTables ¥ I_ -
okl T
Recummende*)ivutﬁbles ? X
A4 e
Count of Id by BoothMame |~ Count of |d by BoothName
A g S Row Labels ~|countofid [
1 boothusage Data “ 30 1
S
2 & An 461 L]
3 ,d Key tl
] u As a07
4 35512 35 a
—————a w Ba 62
5 35458 354 = ;
6 35475 354 Count of |d by BoothLink Blrl 140 t
Eli 77
Wbt [ Countat il
N 08 3 @ = 80
8 35467 354 o = ES 22
9 35466 354 e wr ES a1 D
:;:.nm,..\- . ET a1
Gt 1A 162
Count of |d by Registra... Jar 405 iR
10 35422 354 R M 17
f
b b ME 354
o " Nc 54
i w Pfi 51
57 i Sa 25
o .
: Ta 69
11 35321 35 Count of Id by Country (+) TEL 29
12} 35280  35] e T~ v GrandTotal 2558
& 33278 33 Blank PivotTable | Change Source Data.. oK Cancel
14 35277 35

1.

For booth comparison, choose Count of Id by

BoothName (i.e., number of attendees who clicked on
or within booths)

ra
—

Row Labels

+ Cogent
+H\asceze

+ Dinostic Clarity
+ Benzocene
i

=L

= E

+E

=T

=B

N

+F

= E

+E

S

+E

I

Grand Total

Cogent was the most popular

booth with the most clicks

T Count of Id
461

407

405

354

162

|| Calibri ~ |11

BI;G"Viv

"N

¥ [ copy
| Format Cells...

Mumber Format...
- [% Refresh
. Sort >
> Remowe "Count of 1d"

Summarize Values By  »

YA A S Y% Y E

-0 .00
<._UU =0

%J, Sort Smallest to Largest

%‘_L Sort Large;L{so Smallest

Meore Sort Options...

2. Sort Count of ID (i.e., attendee clicks) by right-
clicking the count of ID number and Sorting Largest to

Smallest

Details on

attendee clicks

3 |Row Labels |count of Id
4 | =Cogent 461
5 = Email 1
B, #Fa irath 1
e =/Resource 419
8 #AmM 46
g  Bi 1
10 = Bi 24
11 = Mar 24
12 #Bi' Platform Video 46
13 =Bi™ Video 2
14 ='Feb 5
15 =5-Feb 1
16 = Heimn 1
17 F& 1
18 +8-Feb 3
19 +19-Feb 1
20 +Mar 3
21 #KR  Brochure 34
22 + KR of Disease Video 3
23 HKR Video 69
24 HNE 42
25 #Or 43
26 +Se 1
27 # 50 37
28 50 Phase 2 Animated Video 55
29 HTEST 1
30 #Htest link 2
31 #Welcome Video 2
32 + Site Url 17
33 = Social 3
34 # Instagram 1
35 # LinkedIn 1
36 H Twitter 1

3. Click the “plus” to see more
detailed clicks (e.g., names, dates,
emails, etc.)
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p Watch Video Tutorial

Q/D Use Case — Popular Sessions & Presentations (Sec. Watched)

The Presentation and Session cards on the Analytics Dashboard give you a quick glance at the most popular session or presentation

You can also Export the stats for Video Views and compare Presentations and Sessions by Hours Watched vs. Total Duration that could have been watched in seconds

Select view

Type of View

| [ Export Data

File Home Insert Page Layout Formulas Data Review  View  Help Acrobat & L c =

3 |Row Labels -/ Sum of VideoPlayedDuration Sum of VideoTotalDurationClean
1 PivotTable Fields v 8 4 | ® Educational session 17253738 28586073
= | Uil = =] 2 5 | ®Industry Satellite Symposium 11558546 15858523
1P E ® Il 'D' I~ i i\ 0 [ ‘ = 2 Rowlabels -1/ Sum of VideoPlayedDuration _Sum of VideoTotalDurationClean Choose fields to add to report: @ - © Multidisciplinary Tumour Board 6141834 8300620
£ B I IE . 4 i ession 17253738 28586073 = Ke te lectt 4253859 7230138
PivotTablf Recommended JTable IIIustrft\ons I [ PivotChart Sparljhnes 5 | @ Industry satellite Symposium 11558546 15858523 seerch = j\;nm::tiiglulm Tlocation] I 2805281 3957600
PivotTables = = 6 | ® Multidisciplinary Tumour Board 6141834 8300620 = 040 d‘l
. hat : 7 [@Keynote lecture 2253859 230133 9 Award lecture 2020 932410 1190764
ales L LTIE B Paper session 3062690 2040815 10 Keynote lecture 255813 957852
- Recommendkd PivotTables ? * 9 | ¥ Mini Oral session 2941052 2051674 Vfmeotalﬂmﬁﬂ_'ﬂm" 1 Opening session and 1217058 1808984
c2 10| = special symposium 2155579 3030999 V“NPWMDWMW" 12| =/meeting/10404/playlist 1200 1252
- 2 i Y i
o Splear asnl_Bem A Sum of VideoPlayedDuration by SessionType (+) 11| 9ESMO Colloguium 1468575 zaziy O Month 13 Drop by drop makes & 1200 1252
- Speciol session Sargais 12 | @ special session 1277776 2710781 14| = /meeting/10304/playlist 4320 7722
" + special Syrromiuy s b The preview was generated based on a sample of the source data and may |- 13 | @Y logists 1150637 1659712 [ bay
1 |OasisReference ! s e r “/Young oncologis! 15 o i d 4320 47722
not match the end result. 14 | @ eposter Displa 2883 5018 [ FirstName pening session an
2 Sum of VifleoPlayedDurat... pley 1 LactMame - 16 = /meeting/10404/playlist 4320 1]
- Row Labels ~ | Sum of VideoPlayedDuration 15| @ (blank) 1167 6825 ; .
3 lobceSfdd-92dg-4 s d ional " 16 |Grand Total 51277345 76532855 P——— 17 Opening session and 4320 0
4 lobcesSfdd-92d9- e “/Educational session 248424 7 2 : 18| = /meeting/10a04/playlist 50 0
5 l0d107ad8-3d23-4 i sl s s “ePoster Display A74 I8 T Fiters 1l Columns 19 Opening session and 4320 0
. B S—————— + ESMO Colloguium 220962 19 S Values > 20|  =/meeting/10404/playlist/317bbod4-adfb-4a8d-941a-15a414b14bd2 1326 1456
6 j0d107ad8-3d23-4 : ::7:_7:::&:7'.:”“: # Industry satellite Symposium 1584943 :? 21 Introduction to the Keynote lecture 0 83
7 )0d107ad8-3d23-9 *gm * 'f‘__ ®Keynote lecture 735062 > 22 Progress and future perspectives of 1326 1373
8 |0f32d2b6-5dfc-4 = Mini Oral session 3 = 23 = /meeting/10404/playlist/3424716a-ca9. 4080 0
9 Sum of VideoPlayedDurat... ra s 54066 = = Rows Z Values 24 Award lecture 2020 4080 0
= R T— - = Multi p y Tumour Board 714861 = i S s 25| = /meeting/10404/playlist/3d073cc5-de3! 1320 1373
s # Proffered Paper session 500130 26
1 D - 2 PathRaw ~ ||| Sumof VideoTotalDu...
& St ol oo + Special session 131946 a7 T -
n . . 28 . M
= L s = special Symposium szssss L 3. Click the “plus” to see more detailed
o S # Young oncologists 201766 | Sheet1 | mesting 10404 VideoTrack i Defer Layout Update I k d C .
© Sprcial Sympmium 3 e meeting_ | VideoTrackir ... (¥ [l »
'  (blank) 275 clicks (e.g., names, dates, etc.). Continue to
E Count of PKey by Sessio... Grand Total 7117362 . 9- . ‘
16 J001072d8-3d28-4 i . add PivotTable Fields as needed
17 {00107808-3023-f esompsosn 2. Sort largest to smallest and add PivotTable
18 < dngon: echdonmcione NSCL: Wovelappiooc
x ioca - A Larapean iy gt 4 . . - ~
12 ; Fields including VideoTotalDuration — the
20 S pevdbni s ot et 2 f 2 h h id Id
= , B maximum amount of time that the video cou
22 Blank PivotTable | Change S Data... oK Cancel i i
EIAGIEUE)|| Chanas Source Dofa have been watched (i.e., the length of the video)
& LSESSTUTT TT-OTUO-EEDE FTTTEETITE OLETTITTE SESST

1. Go to Recommended PivotTables >

ion

Sum of VideoPlayedDuration.

Vlgeo PI_ayed The amount of that video that the individual actually watched

uration

Video 1:otal The maximum amount of time that the video could have been watched
Duration
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¢39O FAQs Q

Q. What's the difference between Google Analytics (GA) and CTI Analytics?
A. See slide #3 for a complete answer — but the two most important reasons are:

1. CTlis tracking on an individual basis, so the count of unique attendees is closer to actual. If an attendee blocks cookies or uses a different device, GA
will see each return visit as a new unique attendee.

2. CTl tracks how long an attendee is watching a Presentation or Session. GA only tracks pageviews and, if an attendee watches a video for more than 15
minutes, GA will track that as an exit when, in fact, that prolonged view is actually a sign of engagement.

Q. What if | want to see more than the Top 50 sessions for any metric?
A. All the data is available by clicking the Export link in the upper right-hand corner of the page. This is “raw” data and pivot tables will help organize
Q. What are best practices for judging the effectiveness of a topic or Presenter.

A. We believe Hours Watched vs. Total Hours Available to Watch is the gold standard for assessing the effectiveness of a topic or Presenter. Page views are the
equivalent of attendees reaching the session door. Hours watched show if they have watched the session and for how long. A Session proves effective if they
continue, on average, to watch the rest of the video. To see the video watch for all presentations and sessions, click the Export link in the upper right-hand
corner of the screen.

Q. How often are CTI analytics updated during the meeting?
A. Typically every two hours for meeting content. The exhibitor statistics are updated in real time. But it can take up to 48 hours to update.
Q. Could Unique or Total Impressions be different for multiple sponsor banners if they're on the same site page?

A. If the sponsor banners are on the same page, they would usually be the same for unique and total impressions. Unique being different individuals and total
being any time someone saw the banner including repeats. If the uploader of the sponsor banners uploaded at different times, the unique or total
impressions could be different even if they are on the same page

Q. Are Analytics tracked when the site is not yet live?
A. Analytics is not dependent on the site being live. Analytics are tracked when the developer activates the analytics meaning you may be still building the site
Q. Is Google Analytics an option?

A. We support Google Tag Manager as an analytics option. The client can provide their code and is implemented in cAttendee Settings > Custom Tracking Code 21



Q/D @ Glossary

Each ‘Card’ (e.g., Attendee, Session, Presentation) on

the Analytics Dashboard has different drop-down

categories with similar key terms. You can find all the

definitions in the Glossary on the left-hand side of the
Analytics Dashboard and below. Use the definitions to
analyze certain CTl meeting statistics

Meeting statistics
 Tips Y Total Attendees: EEE)
View different meeting letrics
with the top drop-down [penus,
and then segment thosdtesults
with the bottom dropdofin
menu. Meeting statisticll can be
exported as a CSV file f|
further analysis.
oM OMar  TIMar  TMar  I5Ma  16Mar  T7Mar  IBMar  19Mar  20Mar  21Mar  DRMa  25Ma 24Mar 25Mar

3 How'to (4) 4
> Analyze Statistics . N .
> Analyze Total Attende Attendee R [ EXPORT Session [7 EXPORT
> Export Dashboard Da Attendee Count All Dates b ~ Top 50 by Attendees Visiting Session Page ~
pdERpOrtiVceting ati Ny Attendee Count All Dates
v Attendee Session Count All Dates b N T. T. & Al

/ Glossary (17) ~

ry Attendee Presentation Count All Dates 3 ® Nov 499
5 Attendee Count Attendee Count Meeting Dates
3 Attendees Visiting Attendee Session Count Meeting Dates ) S Lo 475
Presentation Page Attendee Presentation Count Meeting Dates
> Attendees Visiting Session Attendee Count Post Meeting Dates 5 9 Opti 454
Attendee Session Count Post Meeting Dates

> Attendees Watching Attendee Presentation Count Post Meeting Dates 1 ¥ Hei 438
> Booth Actions / Action Types 20210512 470
> Booth Type 1 % Prof 412
> Certificate by
Code Attendee Count All Dates by Registration Code V‘ ‘ Attendees by Registration Code ~

> Certificate Count By Day
> Certificates by Region

> Gallery Type

> Hours Watched

> Impressions

> Opportunity

CONTACT US

Attendee Count

Count of PKey

Attendees Visiting
Presentation Page

Attendees Visiting Session
Page

Attendees Watching
Booth Actions/Action Types

Booth Type

Certificate by Registration
Code

Certificate Count By Day
Certificates by Region
Gallery Type
Hours Watched
Impressions
Opportunity
Presentation Page Visits
Session Page Visits

Video Played Duration

Video Total Duration Clean

Number of individuals who visited based on registration or SSO data

Number of clicks on the page

Number of individual visitors to page (not known if they stayed to watch)

Number of individual visitors to page (not known if they stayed to watch session)

Number of individuals who start to watch. Elapsed time monitored by triggers that go off every 120 seconds
Actions are clicks on links or buttons. Types include Submit Inquiry, Chat, Resources links

Benefit level, typically labeled as Platinum, Gold, Silver, Bronze, etc.

Number of Registrations by Code #

Number of attendees who received a certificate that day

Number of Registrations by Region in the world (hover to see numbers)

Such as Profit and non-Profit, or Association Booth and non-Association

Total time attendees watched. Elapsed time monitored by triggers that go off every 120 seconds
Number of attendees who could have viewed during the Sponsor Banner display

Location where Sponsor Banner is displayed

Number of page visits (include those who returned twice, but not known if they stayed to watch)
Number of page visits (include those who returned, but not known if they stayed to watch)

The amount of that video that the individual actually watched

The maximum amount of time that the video could have been watched
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